Limits the Sky With RD1i

By: Mike Zaringhalam




Who Am |[?

» Using the IBM i for almost 3 years
-rom P.C. Richard & Son
» In the office | am known for

» RDi

» DB2
» Modernization

» Aspiring speaker

v




What Will Be Covered?

» Opening a member

» Code templating

» Snippets
» Templates

» Compiling
» Debugging
» Shortcuts




What Will Be Covered? (Continued)

» Content assist

» Filters

» Search tools

» Comparison tools

» Open multiples of the same source
» Help!

» & More...




Workspace

I:} Eclipse Launcher

Select a directory as workspace

IBM Raticnal Developer for i uses the workspace directory to store its preferences and development artifacts.

Workspace: rati Browse...

[[] Use this as the default and de not ask again

» Recent Workspaces




Creating a Connection

File Edit Source Navigate Search Project Run Window Help

» Welcome tab is = ...«
shown on first &
startup of RDi

) Overview

= Welcome! Take a few minutes to become familiar with the features in

» Close this tab
to begin ,‘{ IBM Rational Developer for i

IBM Rational Developer for i is an integrated development environms

. . run on IBM i.
Sett] n g th] n gS RPG and COBOL Development Tools fori »

p . jj Java development
W

. Get familiar with developing Java programs using Eclipse




Creating a Connection (Continued)

File Edit Source Navigate Search Project Run

» Locate the ' EBREPHD R I
aE NS
3
SYStemS Explorer 45 Rem.. X “& Navi.. a2Eipr. ~ ®
vView

L8 ek B 5 -

X New Connection

= IBMi...

» Expand “New & Local..
Q 1) B Local
Connection = per

» Double click “IBM |”




Creating a Connection (Continued)

(,#) New Connection

» Fill in

Remote IBM i System Connection

Define connection information

connection

information  peveene |
Host name: [192.168.1.1 | ]
Connection name: | My First Connection!| J
Description: | l

B Verify host name

(7] ik | Neds inish Cancel




Creating a Connection (Continued)

» SSH option
for secure
connection

(.2) New Connection

IBM i Communications Configuration

Connection Properties

B Set ausxiliary storage pool group

Name of auxiliary storage pool group: |

CCSID used for this connection job

o < Back I

MNext >

Finish

Cancel




Opening a Member

» Remote Systems View
» Shortcut - CTL + ALT + Q

» PDM perspective
» Object Table view




Opening a Member:
Remote Systems View

4 Remote Syste.. X "% Navigator 2FiProjectsNa. !

» Large number of members will L2 .8 B S
£ New Connection

cause delay ¥ Loca
RE PCR

» Drop down lists % Objects

&g, Work with libraries...
» Typing jumps to source = Workwith objects.
a3 Work with members...
=t Library list
Z* User libraries
=
ol QREPGLESRC PROMOTIONS
v* QCLSRC
r* QDDSSRC
v* QORPGLESRC
% AASKELETONM.rpgle
% ABSKELETOM.rpgle




Opening a Member:
Shortcut

> Shortcut - CTL + ALT + Q '_:11 Open Member In Editor

. Connection: 8N il | MNew...
> QU]Ck and easy Library: 'H Browse...
» Saves recent values bl [QreGLESRC L] | Browse..

. Member: Browse...
» Options: _
: @ Openforedit O Open for browse
» Edit

» Browse

OK Cancel




Opening a Member:
Object Table View

M Field Table ‘@ Error List « IBM i Service Entry Points B Commands Log # Remote Search W Job Log » Debug M Object Table X

PCR: Filter string ™CURLIB/QRPGLESRC(T5T*) MBRTYPE(*) MBRTEXT(*) (29 Members)

s s h 8

Filter Subset

TSTALIAS RPGLE

TSTCLOB SQLRPGLE

TSTCMBFLD SQLRPGLE

TSTDATES SQLRPGLE

ISTDYNSQL SQLRPGLE

TSTEML SQLRPGLE

TSTFORMS RPGLE ”

MNormal

Library SURVEYOR added to library list.

PCR

*CURLIB

QRPGLESRC

TST*

#




Opening a Member (Continued)

» Open multiple members at once
» Working member is highlighted
» Easy to switch

7 TSTSTUFESQL. / TSTSOLRPGLE ~ ~ TSTCLOBSQLR..  ~ TSTISONSQLR.. TSTSQOLSCLRPGLE X #

+++++++ -I-H-I--I-+ ++4+4++ ++++|:E|||'ﬂ|'|'|E'r'| t 54+

SrcStmt @ *NoDebugIO)
3




Code Templating

» What is it?

» Functionality for inserting repeated code
» Why use it?

» Reusability

» Minimal typing

» Less errors

» Faster

» Easy to use




Code Templating:
Types

» 2 types of templates in RDi:
» Templates - static
» Snippets - dynamic or static




Code Templating:
Templates

» Where are they located?
» Open RDi preferences (Window -> Preferences)
» Search for “Templates”
» Choose Templates under “ILE RPG”

» Recommendation - rename templates to begin
with “Template_"

» Easier to find using content assist




I,») Preferences

Remote Reconciler
Remote Systems LPEX Editor
IBM i Parsers
C/C++
CL
COBOL
DDs
ILE RPG
Content Assist
Formatter
Free-form SQL For
Key Behavior

RPG/400
SSL/TLS
Report Design
Run/Debug
Selection Feedback

Server

Code Templating:
Templates (Continued)

Templates - =
Create, edit or remove templates:
Mame Context Description MNew...
FOR_TO._... | FREE-FORM | The FOR operation begins a ... Edit
FOR_DO... | FREE-FORM | The FOR operation begins a ... —
FOR_BY._... | FREE-FORM | The FOR operation begins a ... Remove
FOR_BY_.. | FREE-FORM | The FOR operation begins a ... Import...
DOW _lo... | FREE-FORM | The DOW operation code pr...
DOU_lo.. | FREE-FORM | The DOU operation code pr... Export..
vd |F_state... - e IF operation code allow... port All...
M r FREE-FORM | The IF i de all Ex All
" IF_ELSE ... | FREE-FORM The IF and ELSE operation c... Enable Al
FREE-FORM | The select group conditiona...
. .- == Disable All

SELECT;
WHEN ${CURSOR}indicator expression;
/{ Insert conditional block here
WHEN indicator expression;
/{ Insert conditional block here
// Insert more WHEN blocks here
ENDSL;




Code Templating:
Templates (Continued)

» How do | use it?

» Use content assist for
template selection

» Template contents displayed
when highlighted

DCL-PROC sqlOptions;
DCL-PI *N;
END-PI;

EXEC SQL
SET OPTION
COMMIT = *NONE,
DATEMT = *IS0;

selel
R select SELECT;
=N SELECT_group - The select group conditio WHEN ${CURSOR}indicator_expression;
B SELECT_OTHER_group - The select group « sz, 2R 2l BIEEs 157

i " 'WHEN indicator_expression;
7/ SELECT_FROM_JOIN_WHERE - The SQL SEl| // Insert conditional block here

B SELECT_FROM_WHERE - The SQL SELECT ¢ // Insert more WHEN blocks here
B SELECT INTO_FROM_WHERE - The SQL SE OTHER;
_— 1 /f Insert conditional block here

ENDSL;
@ Remoie >ear.. #JobLlog = uebug MO




Code Templating:
Snippets

» Where are they located?

» Open all RDi views
(Window -> Show View -> Other)

» Search for “Snippets”

» Recommendation - add this view to a
perspective

» Save the perspective

Snippets

& General
-}

OK

Cancel




Code Templating:
Snippets (Continued)

» To edit/add snippets, right click within the view
and choose “Customize”

W Properties = Monitors B Snippets X &

(= JSP

2 RPG

t=1 POI (Excel Spreadsheet) Template

= Skeleton - RPG Program

i Procedure Documentation




Code Templating:
Snippets (Continued)

= & Skeleton - RPG Program
wn Move Up Import Name:

» Options to add, 7 (S hogan

Description:
& POI (Excel Spreadsheet) Template

u pd ate ’ a n d -1 skeleton for an RPG program

B Procedure Documentation
M Hide

delete

pgm_name Program name

» Select a snippet to
be displayed

Template:

// ${pgm _name_with_spaces}

[/ Programmer: Mike Z

// Date

I

J/ Title

// Project :
<

| Insert Variable Placeholder... |




Code Templating:

Snippets (Continued)

» How do | use it?

» Double click within
the Snippets view

» Snippet variables
will be prompted
before code
insertion

'._\_-_f‘ Insert Template: Skeleton - RPG Program

Variables:

. pgm_name EEEEE

pgm_name_with_spaces

Description of variable;

Program name

Source:

//copies

DCL-PR ThisPgm ExtPgm('aaaaa');
END-PR;

DCL-PI *N;

Insert

Cancel




Compile Commands

» Compiling in RDi WILL simplify the compile process
» Save commands (Per object type)

» Any system command can be an RDi compile
command
» CPYSRCF
» Compile commands shown are based on the active
source’s type (member type)

» SQLRPGLE, RPGLE, CLLE, DSPF, ETC...




Compile Commands (Continued)

» Where are they located?

» Open up the “Work With Compile Commands” window
(Compile -> Work With Compile Commands)

» Recommendation - Use RDi’s compile variables

» Dynamic commands

» Recommendation - Prompt compile commands
» Prevents error




Compile Commands (Continued)

I.‘_-'f.' Work With Compile Commands

» Choose source type Parent profile
» Choose a compile command ™ a—
tO ed]t Compile Commands:
eW COmman Selected compile command:
» Select “New Command” for... |wsaws @ —
CRTBNDRPG Label.
new commands CRTRPGMOD Command:
. SIELE S CRTSQLRPGI OBJ(&0/&N) SRCFILE(&L/&F) SRCMBR
» Use Cg)ntent. assist for :rﬂsmt Pl I
compile variables CPYSRCF
SQLRPGLE MOD Insert variable... Edit... Browse...
» Variable description will be oL SR —
displayed SNDNETOBJ 295
SNDNETOBJ 296 - —




Compile Commands Variables

&F - Name of file containing selected member
&L - Object or member library name

&M - Name of selected resource
&0 - Object library, from Command Execution properties
&R - Replace object when compiling. *YES or *NO. From Comm:

&X - Object or member text, in single quotes




Compile Interactively

» By default, RDi compiles in batch

» To compile interactively
» Go to your connections properties

» Choose “Subsystems” and select the
“Commands” tab

» De-select “Compile in batch”

(%) Properties for PCR

Connection
Connector Services
Host

Subsystems

yects 5 Commands

Properties for running remaot
this connection, or inherted
preferences page. To speci
the left of the property so th

Preferences for compiles a

[l objectlibrane|

Al |
[:] @ Compile in batch




Compile Interactively (Continued)

» See compile errors
» No need to search spool

# Field Table W Error List X & IBM i Service Entry Points 8 Commands Log # Remote Search ‘WJob Log » Debug B (

. ID Message
f] les ! B | RNS9308 Compilation stopped. Severity 30 errors found in program.
. X | RNF7503 Expression contains an operand that is not defined.
> E rro rS a p pea r ] n t h e X | RNF7503 Expression contains an operand that is not defined.
. . X | RNF7030 The name or indicator A is not defined.
E rro r L] St V] ew X | RNF7030 The name or indicator B is not defined.
8 | SQL1103 Position 22 Column definitions for table OLDMODELSFORPROMOS in QTEMP not found.
g 8 |SQL1103 Position 20 Column definitions for table NEWMODELSFORPROMOS in QTEMP not found.
> DO u b le C l] C k e rro rS to & (SQL1103 Position 22 Column definitions for table OLDMODELSFORPROMOS in QTEMP not found.

jump to bad code :




Compile Interactively (Continued)

» Recommendation - hide information messages
» Less displayed messages

J QObJectTable x”** i Pronertie 2 Monitors B NNNDe e
Messages > & Warning

Connection & Frror

Automatically Remove

/QRPGLESRC
/QRPGLESRC
30 50 fQRPGLESRC PCR
30 49 fQRPGLESRC PCR
30 50 /QRPGLESRC PCR

i Severe

Automatically Insert

Message Style




Debugging:
Service Entry Points

LRV B By —_ l_rll'\ll__-'

DATFMT = *IQ-

MNew

» What is it? PROC; - o

Syntax Check Line

> Entry breaprint fora 1l Save Ctrl+S

program Crl+nsert

Paste

» How do | use it? e
Selected
> nght click the sourceyou Desciec ]
wish to debug il

SNOW a

=

Program

» Select “Set Service Entry e
Point” )

View

Add/Remove Breakpoint

% Set Service Entry Point...




Debugging:
Service Entry Points (Continued)

(.#) Set Service Entry Point

» Form will be filled in
» Alter as needed

Connection; MNew...

Library: | ' Browse...

O Program:
'E Browse...

@ Service Program:

Module: *

Procedure;

User ID:




Debugging:
Service Entry Points (Continued)

» Maintain Service Entry Points
» Refresh Entry Points after recompiling

@ Field Table WErmor List « IBM i Service Entry Points X ® Commands Log # Remote Search W@ Job Log » Debug B Object Table

'r - 5 nm
Library Program Program Type Madule Procedure User ID Connection
TSTSTUFF 8 o *ALL PCR

at o8
# Modify
¥, Open Launch Configuration

Remove

Jisable
=% Refresh
W D Viode
#% Code Coverage Mode

Select A
l I




Debugging

» How do | know when | am debugging?
» Debug perspective will open
» Debugged program will show a highlighted line
» The following buttons will light up

() workspace - DDS Design 2.0 - RemoteSystemsTe

File Edit Source Compile(G) Navigate Searcl
‘W ER&EPNIDIH I 5

» TERMINATE EXECUTES CODE UNTIL PGM ENDS




Debugging:
Breakpoints

- - A "

» Right click desired line

» Select “Add/Remove
Breakpoint”

clear tmpPromo#;
clear tmpqyseq#;

AA A QA C 1o ..

Add/Remove Breakpoint

% Set Service Entry Point...

Show Quick Diff Ctri+Shift+Q

Show Annotation

» Double click margin
» Toggles breakpoint

Add Bookmark...

Add Task...




Debugging:
Breakpoints (Continued)

» Breakpoints view *+ Breakpoints X @ Palette .
: : : X% Mo Th RS
» Quickly edit breakpoints ® NULLSTST.SQLRPGLE [line: 48]
; = NULLSTST.SQLRPGLE [line: 72]
» Stay until removed 0

» Easy to get around
» Jump to line
» Open member




Debugging:
Breakpoint Conditions

» Right click
breakpoint (works
in view as well)

» Select “Edit
Breakpoint...”

0ea374 CLOSE GETOLDDTLS;

= MEa0 1SPLY ECHAR ) _po ExistingDet:
Add/Remove Breakpoint ExistingDet:
Enable/Disable Breakpoint
Edit Breakpoint...

¥ Set Service Entry Point..

Show Quick [hff

Show Annotation

Add Bookmark. - M Commands
Add Task.

. Session]




Debugging:
Breakpoint Conditions (Continued)

lu#) Edit a Line Breakpoint

Optional parameters

&

Make the breakpoint conditional upon the following parameters

Frequency

From: | 1 |
To: | Infinity I
Every: | 1 I

Expression: | a = 1|

B Suspend all threads when the breakpoint is hit

(7] < Back I Next Einish Cancel




Shortcuts

B ;
“To get back down to the main level you

have to take the elevator — which is right
up those stairs.”

N




Shortcuts - Generic

» Ctr
» Ctr
» Ctr
» Ctr
» Ctr
» Ctr

|+ S - Save
|+ C - Copy
|+ X - Cut

|+ V - Paste
|+ Z - Undo

.+ Y - Redo




Shortcuts - Useful

» Ctrl + Backspace - delete the line your cursor is on

» Ctrl + Delete - delete everything to the right of the
cursor

» Ctrl + D - duplicate current line

» Ctrl + A - select all

» Ctrl + F - find/Replace

» Ctrl + W - show all lines. Resets any filters

» Ctrl + Shift + D - search lines by the date it was
changed




Shortcuts - Useful (Continued)

» Ctrl + Shift + C - compile using the last used
compile command

» Ctr

wit
» Ctr
» Ctr

» Ctr

| + F5 - removes any syntax/compile errors
nin the editor

| + / - comment out the current line
| + \ - uncomment the current line

| + Space - content assist




Shortcuts - Jumping Around

» F3 OR Ctrl + Click - jump to declarations

» Alt + Left Arrow - jump to previous positions

» Alt + Right Arrow - jump to positions jumped from
» Combine the effects of F3 and Alt + left arrow

» Ctrl + E - reveal a list of all program tabs open
» Type to make the list more concise




Shortcuts - Finding Files

i;2) Open Member In Editor

» Ctrl + Alt + Q - open Member menu

Library: | Library

File  |QRPGLESRC

» Typing in Remote Systems Explorer ....m==
will jump to any files that you have e 0
available

AF Remote Syst.. X " Navigator = i Projects N... - N

LA e B S

%g TESTSPL.rpgle

®g TST.sqlrpgle

%y TSTGWC.rpgle

g TSTPOSLOGZ.rpgle

¥g TSTRANDOM.rpgle

¥g TSTRANDOMZ.rpgle
¥g TSTRAR.rpgle

%g TSTRMD.rpgle

% TSTSOL.sglrpgle

%g TSTSTUFF.sglrpgle




Shortcuts - Select Rectangle

» Alt + R - begin rectangle block selection

» Alt + R OR Click and Drag - finish rectangle block
selection

» Once the block is selected:
» Alt + U - deselect block (or double click anywhere)
» Alt + D - delete selection
» Alt + C - paste selection at cursor position (code shifts right)
» Alt + Z - paste selection at cursor position (overwrites code)

» Alt + M - paste selection at cursor position and delete
selection




Shortcuts - Flow and Indentation

» Ctrl + Shift + M - skips to the end/start of a block
of code

» Ctrl + M - selects the block

» Ctrl + Shift + F - auto format code based on YOUR
indent settings

» Ctrl + Shift + O - display the flow of the selected
statements (Ctrl + F5 resets the arrows)




Shortcuts - Debugging

-5 - step into
-6 - step over

>

>

» F7 - step return
» F8 - resume program

» Ctrl + F2 - terminate program




Shortcuts - Shortcut of All Shortcuts

» Ctrl + Shift + L - shows all shortcuts




Shortcuts - Creating your own

J Preferences

| | Keys

General A

» Preferences -> |

Compare/Patch I
Conte”t T',"peS CU'Y"H&HIJ >
G e n e ra l = > Keys Editors Surround With Quick Menu  Alt+Shift+Z In Windows Source
Globalization a-space Alt+Space LPEX/emacs LPEX
a-t AltsT LPEX/eclipse LPEX
> C reate / a lte r Network Connections K i et ek
Perspectives a-t AltsT LPEX/Ipex LPEX
h t t Search Terminal view insert Alt+T Terminal widget ... Terminal view co..
S O r C u S Security a-u Alt+U LPEX/eclipse LPEX
Service Policies a-u Alt+U LPEX/emacs LPEX
Startup and Shutdown S AltsU LPEX/Ipex LPEX
Tracing Move Lines Up Alt+Up Editing Text Text Editing
Ul Responsiveness Monitorin
Web Browser Paste Alt+V In Windows ASA 9.x table sch..
Workspace Terminal view incert Alt:V Terminal widaet  Terminal view ¢
Agent Controller
Ant [ Copy Command "w\bind Command " Restore Command I
Application Diagram
Bash

Name: Page Up
Description: | Go up one page

Client Certificates
Data Management
DevStyle

Ecore Diagram Binding: lAIt«V

Help
i Projects When: LPEX/emacs

IMP




Content Assist

» What is it?
» Autocompletion list
» Provides helpful details

» Why use it?
» Less errors
» Fast
» Detailed descriptions




Content Assist (Continued)

» Useful with longer names

remove
B S S R R e (e R el st lire move NewItemsPreventingOriginalPromoltemsFromQualifying
EXTPROC(REMOVENEWITEMSPREVENTINGORIGINALPROMOITEMSFROMQUALIFYING")

& removeNewltemsPreventingOriginalPromy
(

= removePromo

:{, promo packed(9,0) CONST

u...removePromos' numOriginalitemsThatNoLongerQualify packed(3,0) CONST
& removePromotion TPRMI LIKEDS(PRMI)

& removePromotionsWithReturningltems TPRMO LIKEDS(PRMO)
{  CPNRIPI packed(3,0) DIM(MAXCPNRIPISIZE) CONST

# removepromos
numCPNRIPI packed(2,0) CONST




Content Assist (Continued)

- —— _—— - o= = - mp m— L —— m——— - —-—

DIM(10);

> HOW dO I use ]t? iswers likeds(T _getPromptingQuestions answers)
DIM(25);
> CTL + Space mQuestions like(T ketPromptingQuestions numQuestions);
PR; :
» Hit Enter for e e ey
selection
DS T_getPro ased(Empty) ;
scription 1
nefitGrp 1
» Hover to show 05
entire item DS T_getProi Based(Empty) ;

iswerIdx PACI
woices likeds(T_getPromptingQuestions choice)
DIM(10);




Content Assist (Continued)

» Recommendation - use Content Assist when calling
a procedure

» Displays parameter list

getPromoDataFromMemory (OGPRMI

& getPromoDataFromMemory getPromoDataFromMemor

EXTPROC(GETPROMODATAFROMMEMORY")
\
OGPrmI LIKEDS(prml)
OGPrmO LIKEDS(prmO)
promo2idx LIKEDS(T_promos_promoZ2idx)
promo2Cnt packed(3,0)
QY LIKEDS(T_QY)
/ /At this point ¢ numQy packed(3,0)
//can return wh QZ LKEDS(T_QZ)
numQZ packed(3,0)




Filters

*) workspace - DD5 Design 2.0 - RemotebystemsTempFiles/

File Edit Source Compile() Mawvigate 5earch Project Eun

' AMAMPUHBTR 3 FET deixr [ g

I|I|.,‘II

» Find members
faster

1§ Remote Systems X " Navigator ¥ i Projects Navigator - -

L =9k B 5 -

£ New Connection
® Loca
RE PCR
=a Objects
oy Work with libraries...
&y Work with objects...
&g Work with members..
&t Library list
2* User libraries
=
" fORPGLESRC PROMOTIONS




Filters (Continued)

» Asterisk (*) used as P
a Wi ldcard Member Filter ::1

Create a new IBM 1 member filter

» Substitute one or
more characters

Maore Types= =

Source members M Data members

0 Cancel




Multiple Criteria Filters

» Create a filter that will T

Filter Information

find 1 source

» Right click filter and
select properties

» Select “Filter Strings”
» Use “New filter string”

/QRPGLESRC PROMOTIONS

Filter Strings

Filter name:
Parent filter pool:

Filter strings:

New filter string
{QRPGLESRC

[ 'QRPGLESRC PROMOTIONS

CMN-PCR-com.ibm.etools.iseri

Selected filter string:

subsystems.qsys.objects

/QRPGLESRC( Libra
/QRPGLESRC{ E8

Member types to subset by:

RPGLE
SQLRPGLE




Search Tools

» What is it?

» Functionality that returns lines of code that matches
your search criteria

» How do | use it?
» CTL + F - String search
» CTL + SHIFT + D - Date search




Search Tools - Strings

» Search for a string with many options
» String replacement

(compareHistoryToCurrent)
“'nc | compareHistoryToCurrent ' Next | | Previous | | All

Eeplace |R§place all

=

Replace | excelBook

B Restrict search to selection I Restrict search to columns Start colurnn Endl calurrin

‘ B Case sensitive Il Whole word Il Regular expression B Wrap I Select found text



Search Tools - Dates

» Search for lines of code using altered date
» Different search options given

RSLGO6AA: Date 200119 not found
Find Date (YYMMDD): | 2007079

To {¥YMMDD:

Previous | | A

O Equal to @ Less than @ Greater than @ Range Il Wrap




Comparison Tools

» RDi provides 2 code comparison tools
» What is it?

» Functionality to view changes between 2 sources
» How do | use it?

» 1. Select 2 members in the Remote System Explorer,
right click, and choose compare

» 2. Select the following symbol in the toolbar

%,




Comparison Tools (Continued)

» Recommendation - Use the Remote System
Explorer Comparison

» Capability to copy code differences from one member
to another

» Sadly, the background is white




Open Multiples of the Same Source

» What is it?

» Capability of having the same member open multiple times
(maximum of 5)

» How do | use it?
» CTL + 2 - open view
» CTL + O - close view
» Why use it?
» Prevent jumping around code
» All sources kept in sync




Multiples of the same source
Continued

Line 23
I‘..+....l.A..+.A..Z.A..+.A..3.A..+.A..d.A..+.‘..5.‘..+....6.A..+.A.f

I 3

Column 1 Replace 3 changes

dsply "not found';
ELSE:

dsply "found®;
endif;

f//Book = ss_open(templateloc);
Book = hssf _open(templateloc);

if Book = *Null;
ss_end_object_group();
*inlr = "1°;
return;

endif;

str = New String('Sheetl');

Sheet = SSWorkbook_getSheet(book:str);

num = S55heet_getLastRowNum{Sheet);
dsply num;

num = S5Sheet_getPhysicalNumberOfRows (Sheet); //# of rows wi

dsply num;

ss_end_object_group();
RETURN;

{pnd-fres

f/1last row with data in

Line 2@

JSORPGLESRC(TSTPOIT): 2
Column 38 Replace 3 changes

..+....1....+....2....+....3....+..I.d...

d sheet
d num
d Str

[free
55 _begin_object_group(10080) ;

if @checkIFS(templateloc) < 8;
dsply "not found®;

ELSE;
dsply “found®;

endif;

[/Book = ss open(templateloc);
Book = hssf_open(templateloc);

if Book = *Null;
ss_end_object_group();
*inlr = "1°;
return;

endif;

edr — Maw Strinal "CShaat1 ') -

R T TR S - TR

like(sssheet)
like(JINT)
like(jString)



Help!

» Editor help
» Help -> Help Contents

» Code help
» Source -> ILE RPG HELP

» Open help window
» F1




Multi-line code shift

» Highlight lines of code to be shifted based on
indentation settings

» Tab - shift code right
» Shift + Tab - shift code left




Refactoring

» Renaming an item

2802900
e300
203100
003200
803300
Be3400
803500
2036000
803700
803800
803900
224000
284180
884200
884380
2804400
2804500
2a4600
ee4700

DCL-PI *™N;

END-PI;
SET OPTI{ Cut Crrl+X
COMMIT = Copy Ctrl+Insert
DATFMT = —_
3
Filter view
Refactor > Rename... Alt+5hift+R
Source
Nel -PT =N - View

Add/Remove Breakpoint




Quick Access

» Search bar for almost anything

I
. « s ; . . "
- - *+ Breakpoints X @ Palette - .
n‘ » »m / x ". . x X’ .. ' @ J! h . .'.. Y-

~




Hovering

getPromoDataFromMemory (OGPRMI

getPromoDataFromMemory( OGPrmli LIKEDS(prmil):
OGPrmO DIM(49) LIKEDS(prmO):
promoZ2idx DIM(5) LIKEDS(T_promos_promo2idx):

promo2Cnt PACKED(3: 0): QY DIM(49) LIKEDS(T_QY):

numQY PACKED(3: 0): QZ DIM(49) LIKEDS(T_QZ):
numQZ PACKED(3: 0) )
EXTPROC ( 'GETPROMODATAFROMMEMORY" )

cntHigh

Press 'F2' for focus




Current Code Location

002800
002900
. 9030008| DCL-PROC sqlOptions;
» Displays B [ ocie: o,
. 003200 END-PI;
procedure/subroutine 003300
0 C 003400 EXEC SOl
based on cursor position 003508 |  SET OPTION
003600 COMMIT = *NONE,
003700 DATFMT = *ISO;
003701 |
0039008 END-PROC;
004000
004100
904300 //General program calls
B i e i e e
004600
904700 DCL-PROC promoEngine EXPORT;
004800 DCL-PI *N;
anAnanl moie (HAR(2A) connst -

(sqlOptions)




Work Offline

£ New Connection

» Right Click your connection  :=
» Select “Work Offline”

Work Offline

Host Connection Emulator

Properties




Opening Copy Member

WAL

|.-.I| e

Prompt

Syntax Check Line
I.II:' I r_:

" E fCOPY Member

IND52 LIKEDS(H

rEpr‘Qmpt char

& Edit
:“.I r_:

. Browse
:.:'.l L9 T [

Select
Selected
|'||" |

% str PACKEI

DCL-5 inv PACKE(EES
Filter view
I-"" I c 'Fir‘-S.tpass
Refactor
Source
|'||" |

:--.-\. Tpr,.mI LI

Ilq'l | By




Tasks

» Program errands
» Marks specific line
» Priority levels




Tasks:
Adding a Task

- - A "

» Right click program
margin

» Select “Add Task...”

clear tmpPromo#;
clear tmpqyseq#;

RAAN000 . 2 o
Add/Remove Breakpoint
% Set Service Entry Point...

Show Quick Diff Ctri+Shift+Q

Show Annotation

» Right click within Tasks
view
» Select “Add Task...”

Add Bookmark...

Add Task...




Tasks:
Tasks View

» To-do list
» Easily mark as completed
» Sort by (priority, program, etc...)

M Properties ® Monitors B Snippets 4 Tasks X

2 items

| do something coo SQAL.. | /RemoteSystemsTem.. | lir




The End!

Any Questions?

Contact info:
Mike.Zaringhalam®pcrichard.com




